
MAC CGM ConverterMAC CGM Converter

Computer Graphics Metafile to PICT fileComputer Graphics Metafile to PICT file

conversion for the Apple Macintoshconversion for the Apple Macintosh

Version 2.0
January 1992



©1988-92.  All rights reserved.

MAC CGM Converter  software is the sole property of   PIXELIX.

The information contained in this publication is believed to be accurate and reliable. 

There is no warranty, guarantee, or any representation  with respect to the use or results of the use of the software or  
any accompanying documentation in terms of accuracy, correctness, reliability or otherwise.

In  no  event  shall  we  be  liable  for  any  incidental,  indirect,  special  or  consequential  damages  arising  out  of  the  
purchaser's use of the software.

Information in this document is subject to change without notice.

Apple® and the Apple logo are registered trademarks of Apple Computer, Inc.

Page  2



Table of Contents

                                 Page

Introduction About MAC CGM Converter   4 

CGM to PICT,  PICT to CGM

Summary of Capabilities   6

Known Problems   7

Installation   8

Chapter 1 CGM to PICT:  Getting Started   9

Starting CGM to PICT 11

Using CGM to PICT 12

Options 13

Chapter 2 Starting PICT to CGM 17

Using PICT to CGM 19

Options 20

Chapter 3 Error Messages 23

CGM to PICT Questions 25

PICT to CGM Questions 27

Chapter 4 Example Files 28

Appendix A CGM Packages tested 30

Appendix B Supported CGM Elements 33

Appendix C Output CGM Elements 39

Appendix D References 43

Page  3



Introduction:  Introduction:  About About MAC CGM ConverterMAC CGM Converter

i-1                                                  Page   4



Introduction:  About MAC CGM Converter

MAC CGM Converter contains programs to convert between Computer Graphic Metafiles (CGM) and Apple 
Macintosh PICT graphics files.

The  CGM provides  a  file  format  suitable  for  the  storage,  retrieval  and  transfer  of  graphical  information 
between computer systems of different architectures and graphic output devices of differing capabilities.

The CGM is a set of basic elements defined as an American National Standards Institute (ANSI) standard 
and also as an International  Standards Organization (ISO) standard.  The CGM draws extensively for its 
model of a Graphics System, on the Graphical Kernel System (GKS).

To use MAC CGM Converter you need a Macintosh computer with at least 1Mb of memory.   Even if you use 
a black and white screen with a Macintosh computer, you can convert color CGM files to color PICT files.

MAC CGM Converter consists of two programs - 

1. CGM to PICT 

CGM to PICT converts CGM files to PICT or PICT2 files. 
Once a CGM file is converted to the PICT file format, it is possible to read the picture into most 
Graphics Packages on Apple Macintosh computers.

• expects the CGM to use the "Binary Encoding".
The "Character" or "Clear Text" Encodings are not supported.

Appendix A contains a list of CGM's from various packages tested with CGM to PICT.

2. PICT to CGM

PICT to CGM converts PICT and PICT2 graphics to CGM files.
Once a PICT graphic is converted to a CGM file, you can read the picture into CGM compatible 
Graphics Packages on other computers.
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Summary of capabilities

  CGM to PICT

• On a Mac 512K, Mac Classic, Mac LapTop, Mac Plus, Mac SE or PowerBook 100 creates 
PICT files with up to 8 colors.

• On a Mac supporting color quickdraw (Mac II, IIci, IIcx, IIfx, IIsi,  IIx, LC, SE/30, Classic II,  
PowerBook 140, PowerBook 170, Quadra), creates PICT2 files with an unlimited number of 
colors.

• No limit set on the number of points in a CGM polygon.
• Supports most CGM commands.
• Interprets binary CGM's from any computer system.
• Allows automatic exchange of Black and White colors.
• Option to disassemble CGM 's into a readable text format.
• Automatically creates a PICT file for each CGM picture, or overlays all CGM pictures into a 

single PICT file.
• Option to set the color palette to the Harvard Graphics default color palette.
• Allows the creation of pictures scaled from A4 to A0 in size and supports the CGM scaling 

command. A PICT file can automatically be sized to that of the original CGM, provided that 
scaling information is present in the CGM.

• Background color selection options available.
• Multi-finder compatible -  the conversion may be run as a background process, while you 

continue work on another task.
• Option to preview the PICT file created.
• Runs under system 6.0x, System 7 (24-bit and 32-bit compatibility modes). Supports balloon 

help under System 7.

  PICT to CGM

• Converts PICT and PICT2 files.
• No limit set on the number of points in a polygon.
• Allows automatic exchange of Black and White colors.
• Option to disassemble PICT and PICT2 files into a readable text format.
• Creates an easily interpretable CGM.
• Multi-finder compatible -  the conversion may be run as a background process, while you 

continue work on another task.
• Supports the Macintosh character  set,  also the conversion of  text  to a set  of  characters 

supported  by  other  computers.  Also  can provide  a  "font  list",  so  that  intelligent  graphics 
applications on other computers can use fonts matching those used in your drawing.

• Allows a CGM to be created which contains scaling information,  so that  a  CGM will  be 
automatically scaled to the same size as the PICT drawing.

• Contains  an  option  to  allow  Macintosh  images  to  be  converted  to  the  CGM  (to  a  cell  
array).Even if you are using a non-color quickdraw Macintosh (a Mac Classic for example), 
you may convert 8-bit color PICT2 pixel-map images to a CGM containing an 8-bit color cell 
array.

• Allows a background color to be selected.
• Allows the choice of a CGM supporting "Direct" or "Indexed" color modes.
• Runs under system 6.0x, System 7 (24-bit and 32-bit compatibility modes). Supports balloon 

help under System 7.
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Known Problems

• Not all CGM commands are supported - a complete list of supported commands is shown in 
Appendix B.

Unsupported CGM commands will be ignored by CGM to PICT.

Conversion Incompatibilities

• Some CGM files do not contain a color palette.  These files may need to be edited manually to 
obtain the correct color sequences.

If a color palette does not exist, the colors used are the Technical and Office Protocols 3.0 (TOP 
3.0) color defaults. 

• Text fonts between the PICT and CGM files are mapped onto similar fonts, provided that the font 
is known to CGM to PICT.

A font not known to CGM to PICT with an index number of 1 will be mapped onto the Macintosh 
Font number 1.
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Installation

MAC CGM Converter is supplied on one disk.  Before you start using the  programs you should make a copy 
of the master disk and work with the copy. 

Keep the master disk in a safe place.

The MAC CGM Converter  master disk contains the CGM to PICT and PICT to CGM programs and sample 
files.

MAC CGM Converter is not copy protected, so you can easily install it on your hard drive by following these 
steps -

Turn on your Macintosh

Insert the MAC CGM Converter disk.

Drag the MAC CGM Converter  disk icon onto your hard disk icon. 
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CGM to PICT

Chapter  1:  Chapter  1:  Getting  StartedGetting  Started
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CGM to PICT

Chapter  1:  Getting  Started

Before you can convert a CGM file to a PICT file, you must use a communications package to transfer the 
CGM file from the computer that it resides on, to your Macintosh computer.

The file transfer must be in a binary mode (ie. not a text transfer). Most communications packages allow the  
transfer of binary information.

The  file  transfer  must  not  exchange  any  characters,  such  as  Carriage  Return  to  Line  Feed;   or  Insert 
characters at any time, such as a Line Feed after every 80 characters.

If a CGM is not transferred exactly as it was on the host computer, then errors will occur when you proceed 
with the conversion.

Alternatively, Apple File Exchange may be used to transfer CGM files from MS-DOS format to Macintosh 
format.

The CGM file on the Macintosh must be of file type BINA (for binary), CGMF or TEXT. If you transfer the file 
to the Macintosh as another file type, then when you execute CGM to PICT, you will not be able to proceed.

If the CGM file is not of type BINA, CGMF or TEXT, then you may use a file editor (such as Resedit or Mac 
Tools, etc) to change the file type.
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CGM to PICT

Starting  CGM to PICT

To begin a session:

 1. Turn on your Macintosh.

If you have copied the master disk onto a hard disk, locate the CGM to PICT  application on the 
desktop, or open the folder that contains the application and proceed to step 5.

 2. Put a working copy of your system disk into a disk drive.

 3. Put a working copy of the CGM Converter  disk in another disk drive.

 4. Click the CGM Converter disk icon and choose "Open" from the "File" menu. 

The Macintosh desktop opens, displaying Icons for the application and sample files (Figure 1-1).

Figure 1-1

  5. Click the CGM to PICT  application icon and choose "Open" from the "File" menu (or double click 
the application icon).
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CGM to PICT

Using  CGM to PICT

Once the CGM to PICT program is started, the following desktop will appear -

Figure 1-2

 1. Choose  Open CGM file from the File menu.

A list of the names of the CGM documents contained on the disk will be displayed.  Scroll through 
the list of the documents and click a CGM filename. If your CGM document is not listed, then it is  
not of type BINA, CGMF or TEXT and must be changed (ref: "Chapter 1:  Getting Started").

If the CGM document you're looking for is on a different disk, click Eject and insert the correct disk.

To see the names of documents on a disk in the other drive, click Drive.

 2. Click Open.

 3. Select the necessary options from the Options menu:

For an option to be selected, it must be checked.
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CGM to PICT

The options are - 

Convert to PICT

Allows the conversion of the CGM to PICT graphics files.

The PICT file is compatible with most graphics packages on the Macintosh. You can edit or print 
your picture from a Macintosh graphics application.

Decode to TEXT

Allows the decoding of the CGM to a readable text file.

The TEXT file is editable from most text editors and word processors.
You can read the commands in the CGM file, or print the document. The text listing of the CGM file 
is not as compact as the binary CGM file and will amount to many pages if printed.

Reverse Black and White

Allows the reversal of all Black and White picture elements.

This  option  may  be  necessary  if  the  CGM  was  created  for  a  graphics  display  with  a  black 
background.  The actual picture may look better, printed on a laser printer if the output has a White 
background.

Ignore VDC Extents

Some CGM files have incorrect values for the VDC Extent. If this is the case the picture will not be 
correctly sized (usually appearing in the top right-hand corner of a page). 

To correctly size the picture, you should over-ride the VDC Extents in the CGM by ensuring that this 
option is checked.

If this option is checked, the minimum VDC Extents will be set to (0,0).

Recommended for- GSS, Harvard Graphics, SAS, Super Chart,
Super Image.

Overlay Pictures

Some CGM files contain more than one picture.
When this option is checked, the created PICT file will contain all CGM pictures drawn over each 
other.

If this option is not checked, a separate PICT file will  be created for each picture. The first file  
created is filename-specified, other pictures will be named, filename-specified.picture-number .
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CGM to PICT

HG Color Palette

Harvard Graphics CGM files contain incorrect color table information, resulting in black and white 
converted pictures.

Selecting this option over-rides the incorrect color information contained in the CGM, setting them 
correctly to the default Harvard Graphics color palette. 

The default Harvard Graphics color palette consists of the following colors-

Color Number Red Green Blue Name

  1 1000 1000 1000 White
  2 0 1000 1000 Cyan
  3 1000 0 1000 Magenta
  4 0 1000 0 Green
  5 0 0 660 Blue
  6 1000 0 330 Red
  7 1000 1000 330 Yellow
  8 1000 330 0 Orange
  9 0 0 1000Royal Blue
10 1000 660 0 Gold
11 660 0 660 Violet
12 1000 0 660 Pink
13 660 660 660 Grey
14 660 0 0 Crimson
15 0 330 0Dark Green
16 0 0 0 Black

Set picture size

Select the size of the picture you wish to create. The size of the picture created will be scaled to the 
exact dimensions of the selected sheet size, except for the "Within A4" option.

The "Within A4" option scales the picture to fit with the A4 page using the correct aspect ratio of the 
CGM picture.

The dimensions of the various sheet sizes are -

A4   297 x 210 mm        A3   420 x 297 mm A2   594 x 420 mm
A1   840 x 594 mm        A0 1187 x 840 mm

The "Use CGM Scaling" option will use information contained in the CGM file to size the PICT file. 
Note that some CGM generators DO NOT correctly store CGM Scaling.

The "640 x 480" option sizes the picture to a size corresponding to 640 pixels in the x dimension 
and 480 pixels in the y dimension.
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CGM to PICT

BG color type

A CGM may contain a background color, this option allows the control of the background.

If "None" is selected, the created PICT file will contain no background color, even if a background 
exists in the CGM.

If "From CGM" is selected, the created PICT file will contain the background color as it exists in the 
CGM, either from the background color command or by the setting of Color Index 0 in a color table, 
provided that either of these commands exist in the CGM.

A color table containing a defined color number 0 is usually found in  CGMs produced from GKS 
packages.

If  "Set BG Color..."  is selected, select the preferred color of the background. This will over-ride 
any background color settings in the CGM, setting the background color to that selected.

On a Macintosh supporting color  QuickDraw,  a color  wheel  displaying the available colors  will  
appear.

On a Macintosh not supporting color QuickDraw, a limited palette of colors is available in the pop-
up menu. Click on the displayed color name and select the desired color from the menu.

Display PICTure

If selected, this option will cause the converter to display each picture that is created on the screen 
of your Macintosh.

Cell Array Output

In a CGM, the cell array contains image information in a raster format.
If "None" is selected, the cell array will  be ignored and no Macintosh equivalent for this image 
information will be output.

Selecting "As vectors" converts the raster image to vector format (ie. moves and draws). Note that 
this is recommended for small images only, as a large amount of information is generated by this  
option.
This option is only available on a Macintosh supporting color quickdraw.

Selecting "As a Pixel Map" converts the raster image to a Macintosh image. This option is only 
available on a Macintosh supporting color quickdraw. This option is currently not available in this 
version of CGM to PICT. 
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CGM to PICT

 4. Select Save as...  from the File menu.

The  Save as... option will  be enabled,  provided that  either  or  both the  Convert  to CGM and 
Decode to TEXT options (under the Options menu) are checked, and that a CGM file has been 
selected (Step 1).

Enter a name for the created PICT file, or use the default name suggested. Press the return key or 
click the Save button and the conversion will proceed.

If both the  Convert to PICT & Decode to TEXT options have been selected, you may only specify 
the PICT filename. 
In this case, the TEXT file that will be created will have the same name as the CGM file, with the  
extension, ".LST" .

The  PICT to CGM desktop changes to include a window displaying the progress of the PICT 
conversion, as shown in figure 1-3.

Figure 1-3

At any time during the conversion process,  click the mouse cursor within the cancel area to stop 
the CGM conversion.
You can also quit the CGM to PICT  program immediately by pressing the command key  " "  and⌘  
the period key  "."  simultaneously.

If an error occurs during the conversion process, an error alert will appear.  The type of alert shown 
will depend on the severity of the error. A less severe error will allow the option of continuing or 
stopping the CGM conversion.
A more severe type of error will require you to acknowledge the error and the conversion process 
will stop. 

 5. Choose the Quit option from the File menu.
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PICT to CGM

Chapter  2:  Chapter  2:  Starting  PICT to CGMStarting  PICT to CGM
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PICT to CGM

Chapter  2:  Starting  PICT to CGM

To begin a session:

 1. Turn on your Macintosh.

If you have copied the master disk onto a hard disk, locate the PICT to CGM application on the 
desktop, or open the folder that contains the application and proceed to step 5.

 2. Put a working copy of your system disk into a disk drive.

 3. Put a working copy of the CGM Converter disk in another disk drive.

   4. Click the CGM Converter  disk icon and choose "Open" from the "File" menu. 

The Macintosh desktop opens, displaying Icons for the application and sample files (Figure 2-1).

Figure 2-1

   5. Click the PICT to CGM application icon and choose "Open" from the "File" menu (or double click 
the application icon).

2-2                                                  Page 18



PICT to CGM

Using  PICT to CGM

Once the PICT to CGM program is started, the following desktop will appear -

Figure 2-2

 1. Choose  Open PICT file from the File menu.

A list of the names of the documents contained on the disk will be displayed.  Scroll through the list 
of the documents and click a PICT filename.

If the PICT document you're looking for is on a different disk, click Eject and insert the correct disk.

To see the names of documents on a disk in the other drive, click Drive.

 2. Click Open.

 3. Select the necessary options from the Options menu:

For an option to be selected, it must be checked.
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PICT to CGM

The options are - 

Convert to CGM

Allows the conversion of PICT files to binary CGM files.
The CGM is compatible with graphics packages on other computers which read binary CGM's. 

Decode to TEXT

Allows the decoding of the PICT file to a readable text file.

The TEXT file is editable from most text editors and word processors.
You can read the commands in the PICT file, or print the  document.  The text listing of the PICT file  
is not as compact as a PICT file and will amount to many pages if printed.

Reverse Black and White

Allows the reversal of all Black and White picture elements.
This  option  may  be  necessary  if  the  PICT  was  created  for  a  graphics  display  with  a  white 
background. 
Graphics screens on other computers usually have a black background. 

Character Set

The "Macintosh" option stores the text characters exactly as they are stored on the Macintosh. 
Graphics systems on other computers may not recognize special characters such as •. If the CGM 
is converted back to PICT, the characters will be correctly displayed on the Macintosh.

If "ASCII" is selected, the characters are set to the normal alphabetic characters (ie. Å to A, • to *), 
so that a graphics system on another computer can correctly display them.

Scaling Mode

The "Abstract" option will specify that an arbitrary picture size will be selected by the graphics 
application. This is the default as all graphics applications support abstract scaling.

The "Metric"  option will  specify that  the picture will  be mapped to a particular size,  the actual  
dimensions of  the picture in  your  Macintosh application.  Not  all  graphics applications on other 
computer systems will accept metric scaling.
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PICT to CGM

Text Font Info

If "None" is selected, no font information will be passed to the CGM. 
This  may  be  necessary  as  some graphics  applications  are  unable  to  interpret  the  "Font  List" 
command that is created in the CGM. 

The "In  CGM"  option  stores  text  font  information  in  the  CGM,  with  the  "Font  List"  command. 
Intelligent graphics applications will be able to use similar text fonts to those used in the creation of 
your picture on the Macintosh.

Pixel Map Output

"None" will specify that no Macintosh bit-map or pixel-map image will be converted to the CGM.

If "Cell Array" is selected, Macintosh images will be converted to the CGM Cell Array data type.

Some graphics applications are not capable of interpreting CGM's containing the cell array.

BG color

A CGM may contain a background color, this option allows the control of the background.

If "None" is selected, the created CGM file will contain no background color.

If  "Set BG Color..."  is selected, select the preferred color of the background.

On a Macintosh supporting color  QuickDraw,  a color  wheel  displaying the available colors  will  
appear.

On a Macintosh not supporting color QuickDraw, a limited palette of colors is available in the pop-
up menu. Click on the displayed color name and select the desired color from the menu.

Color Mode

"Direct" color mode results in the created CGM having colors specified in R-G-B format. "Indexed" 
color mode will specify all colors as an index to a color table. The color table contains the R-G-B 
information required to describe this color.

Some graphics packages may not be capable of displaying colors in direct color mode, supporting 
indexed colors instead.
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PICT to CGM

 4. Select Save as...  from the File menu.

The "Save as..." option will be enabled, provided that either or both the "Convert to CGM" and 
"Decode to TEXT"  options (in the Options menu) are checked, and that a PICT file has been 
selected (Step 1).

Enter a name for the created CGM file, or use the default name suggested. Press the return key or 
click the Save button and the conversion will proceed.

If both the "Convert to CGM" and "Decode to TEXT" options have been selected, you may only 
specify the CGM filename. 
In this case, the TEXT file that will be created will have the same name as the PICT file, with the 
extension, ".LST" .

To stop the conversion at any time, click on the Cancel button.
The  PICT to CGM desktop changes to include a window displaying the progress of the PICT 
conversion, as shown in figure 2-3.

Figure 2-3

At any time during the conversion process,  click the mouse cursor within the cancel area to stop 
the CGM conversion.
You can also quit the PICT to CGM  program immediately by pressing the command key  " "  and⌘  
the period key  "."  simultaneously.

If an error occurs during the conversion process, an error alert will appear.  The type of alert shown 
will depend on the severity of the error. A less severe error will allow the option of continuing or 
stopping the PICT conversion.  A more severe type of error will require you to acknowledge the 
error and the conversion process will stop. 

 5. Choose the Quit option from the File menu.
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Chapter 3:  Error Messages

If an error occurs during the conversion process, an error alert will appear.  The type of alert shown will  
depend on the severity of the error.

If a System Error, such as  "Disk is Full" occurs, you cannot proceed with the conversion.  Figure 3-1 shows 
an example of this type of error.

Figure 3-1

A less severe error alert will allow the option of continuing or stopping the conversion.

If such an error does occur, you can press the Continue button and the converter will try its best to continue 
processing. 

It is quite possible that the converter will be unable to continue reliably due to incorrect data contained in 
the file.

It is important that the CGM file transferred to the Macintosh is exactly as it was on the host computer.
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CGM to PICT  Questions

When attempting the "Open CGM file" command, the CGM does not appear in the list of files.

The CGM will only appear in the list of files if it is BINA or TEXT file type. 
Use a file editor such as Fedit (Mac Master Systems), Mac Tools (Central Point Software Inc.), ResEdit  
(Apple Computer Inc.), Symantec Utilities (Symantec Corp.), etc to change the file type of the CGM to 
either BINA, CGMF or TEXT.

For example, in ResEdit, click once on the CGM filename to select it, then do a Get Info (under the File 
menu), change the Type to BINA, CGMF or TEXT. Close the file, save your change and Quit from ResEdit.

Conversion errors continually appear.

Ensure that the CGM was transferred to the Macintosh using a binary transfer without the exchange of 
characters (such as carriage return, line feed).
For example, using Kermit to transfer files, specify,  Binary or Set type image.
The CGM on the Macintosh must contain exactly the same information as the original CGM on the other  
computer.

The CGM is processed, but only a blank picture is produced.

It is possible that the CGM contains a blank pictures. If the Overlay Pictures option in CGM to PICT is not 
selected, a blank PICT file will be created for each blank CGM picture.

The created picture only fills the top right-hand quarter of a page.

Select the Ignore VDC Extents option in CGM to PICT as the CGM may contain inaccurate VDC limits. 
The picture should approximately fill an A4 page.

Part of the created picture is missing.

A missing object in the created PICTure may actually be there but isn't visible if- 
• the color of the object is the same as the background color.

In a graphics application, select the object and change the color or try the Reverse Black and 
White option in CGM to PICT.

• A CGM object may be missing because CGM to PICT ignores unsupported CGM commands.
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On a non-color quickdraw Macintosh, the PICT file displayed  on the screen (with the "Display  
PICTure" option selected), is a completely  black area.

The CGM probably contains a background color specified. On Macintosh computers not supporting color 
quickdraw, the picture is displayed with all colors appearing as black only. In order to see the picture on the 
screen, turn off the background by selecting "None" in the BG color option.

The created PICT file contains up to 8 colors. Some graphics applications (such as Mac Draw) display 
these colors as shades of grey on a non-color quickdraw Macintosh. Other applications (such as Canvas) 
display the picture as black, it is possible to detect the color of elements by selecting the element and then 
checking the color palette tool.
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PICT to CGM Questions

When attempting to read a CGM created from PICT to CGM into a graphics application on another 
computer, errors occur.

Check that the graphics application is capable of reading binary CGM files.

Ensure that the CGM was transferred from the Macintosh using a binary transfer without the exchange of 
characters (such as carriage return, line feed).

For example, using Kermit to transfer files, specify,  Binary or Set type image.

The CGM on the Macintosh must be transferred to other computer types, creating a CGM with exactly the 
same information.

A picture appears as monochrome in a graphics application on another computer.

The graphics application does not support the CGM Direct Color Mode. 
Colors exist in the CGM but will be ignored. Select the "Indexed" option for the "Color Mode".
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Chapter 4:  Example Files

The Example Files folder contains demonstration CGM files which may be converted to APPLE Macintosh 
PICT format files using CGM to PICT.

The PICT files produced may be viewed by any graphics application supporting PICT or PICT2 files. For  
optimum results use a Macintosh supporting Color QuickDraw with a color monitor supporting 256 or more 
colors.

For the best display of PICT graphic files, use a graphics application which allows the display of 256 or  
more colors.

CONJURE.REV

Conjure is a registered trademark of Vision Control International Pty. Ltd.

Select the following Options -  Convert to PICT

FLPLUS.CHART

Freelance Plus is a registered trademark of Lotus Corporation.

Select the following Options -  Convert to PICT

GENI.CGM

The origin of this demonstration CGM is unknown.

Select the following Options -   Convert to PICT

This CGM contains two pictures. Two PICT files will be created.

HARVARD.CGM

Harvard Graphics is a registered trademark of Software Publishing Corporation.

Select the following Options -   Convert to PICT
    Ignore VDC Extents
    HG Color Palette

SAS.COWBOYHAT

SAS is a registered trademark of SAS Institute Inc.

Select the following Options -   Convert to PICT
    Ignore VDC Extents
    Overlay Pictures
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Appendix  A:   CGM Packages Tested

MAC CGM Converter  has been successfully tested on a large number of CGM's from the packages listed 
below.

If you are using a package that is not listed, your package most probably creates CGM files which are 
compatible with CGM to PICT.

COMPUTER                                PACKAGE TESTED

Apple Macintosh CadMover, Canvas 3.0, GraphPorter, NCAR Graphics.

Data General Corporation CEO Drawing Board, DG/GKS 3.0, SAS version 6, 
MV series Trendview.

Digital Equipment Corp  CA-SuperImage VAX, CA-Tellagraf, CA-Graphics 
VAX series Connection,  GRAFkit, Genigraphics, Lotus 123, PVI-products (DI-3000, 

DRAW,  GK-2000,  GrafMaker,  PicSure,  PicSure  Gold)  through  the 
Extended Metafile System; PLOTIT, PV-WAVE, SAS version 6,  Vivid, 
Zycor Hardcopy System.
DEC GKS via Henderson Software CGM converter.

IBM PC, PS/2 Autumn, Conjure, CoPlot, Corel Draw, Designer, Draw Applause, Draw 
Perfect,  Freelance Plus,  Graphwriter  II,  GSS*CGI,  Harvard Graphics, 
Lotus 123, Mirage, Nova*GKS, Pixie, SAS, Super Chart, Super Image.

Intergraph workstations Intergraph converter between CGM and DGN formats.

Silicon Graphics IRIS Visual GKS.

Sun workstations Landmark, PRIOR GKS, Sun PHIGS, Zycor Hardcopy System.

Note:
SAS version 6 requires that  the GACCESS field  in  the PROC GDEVICE procedure be set  to 
'SASGASTD>GRAPH.GSF' .

Digital Equipment VAX series requires that the CGM be of the file type - FIXED (ie. Fixed record  
length type), STREAM, STREAM_LF, STREAM_CR or UNKNOWN.

The VARIABLE file type contains characters known only in the VAX environment. If CGM files of 
this type are transferred to other computer systems the CGM will be uninterpretable.
Use the CONVERT/FDL command to convert VARIABLE file types to the STREAM/UNKNOWN 
formats before these files are transferred to other computer systems.
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Autumn, Mirage, Pixie  are registered trademarks of Zenographics Inc.
CA-Tellagraf is a trademark of Computer Associates International Inc.
CadMover is a trademark of Kandu Software Corporation.
Canvas is a trademark of Deneba Software, Inc.
CEO, Trendview are registered trademarks of Data General Corporation.
CoPlot is a trademark of CoHort Software.
Conjure is a registered trademark of Vision Control International Pty. Ltd.
Corel Draw is a trademark of Corel Systems Corporation.
DEC GKS is a trademark of Digital Equipment Corporation.
Designer is a registered trademark of Micrografx Inc.
DG/GKS is a trademark of Data General Corporation.
DGN  is a trademark of Intergraph Corporation.
Draw Applause is a trademark of Ashton-Tate.
Draw Perfect is a registered trademark of Word Perfect Corporation.
Extended Metafile, DI-3000, DRAW, GK-2000, are registered trademarks
GrafMaker, PicSure, PicSure Gold, PV-WAVE of Precision Visuals Inc.
Freelance Plus is a registered trademark of Lotus Corporation.
Genigraphics is a registered trademark of Genigraphics Corporation.
GRAFkit is a trademark of SCO Inc, a division of International Computer Exchange Inc.
GraphPorter is a trademark of GSC Associates Inc.
Graphwriter II is a registered trademark of Lotus Corporation.
GSS  is a registered trademark of Graphics Software Systems Inc.
Harvard Graphics is a registered trademark of Software Publishing Corporation.
IBM, PS/2 are registered trademarks of International Business Machines Corporation.
IRIS is a registered trademark of Silicon Graphics Inc.
Intergraph is a registered trademark of Intergraph Corporation.
Landmark is a trademark of Landmark Graphics Corporation.
Lotus 123 is a registered trademark of Lotus Development Corporation.
NCAR Graphics the National Center for Atmospheric Research (NCAR) is a operated by the University Corporation for 

Atmospheric Research and is sponsored by the National Science Foundation.
Nova*GKS is a trademark of Nova Graphics International Corporation.
PLOTIT is a trademark of Enigma Software Ltd.
PRIOR GKS is a registered trademark of PRIOR Data Sciences Ltd.
SAS          is a registered trademark of SAS Institute Inc.
Sun PHIGS          is a registered trademark of Sun Microsystems.
Super Chart, Super Image, CA-Super Image VAX are trademarks of Computer Associates
CA-Graphics Connection International, Inc.
Visual GKS is a registered trademark of Visual Engineering Inc.
Vivid is a trademark of Access Technology.
Zycor Hardcopy System     is a trademark of Zycor Inc.
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Appendix  B:  Supported CGM Elements

Listed below are the CGM Elements that CGM to PICT  supports in the PICT conversion. This is a technical 
reference for those familiar with CGM or for those curious about the details of the CGM.

Appendix D contains technical references which explain the CGM in detail.

   fully supported
P   partially supported
-    ignored

Element Code Element Name CGM to PICT    support  

Delimiter Elements: Class 0

1 Begin Metafile
2 End Metafile
3 Begin Picture
4 Begin Picture Body
5 End Picture

Metafile Descriptor Elements: Class 1

1 Metafile Version -
2 Metafile Description -
3 VDC type

         Integer
         Real

4 Integer Precision
         8, 16, 24, 32

5 Real Precision
         32-bit floating point
         64-bit floating point
         32-bit fixed point
         64-bit fixed point

6 Index Precision
         8, 16, 24, 32

7 Color Precision
         8, 16, 24, 32

8 Color Index Precision
         8, 16, 24, 32

9 Maximum Color Index
10Color Value Extent
11Metafile Element List -
12Metafile Defaults Replacement
13Font List
14Character Set List -
15Character Coding Announcer -
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Picture Descriptor Elements: Class 2

1 Scaling Mode
         Abstract
         Metric

2 Color Selection Mode
         Indexed
         Direct

3 Line Width Specification Mode
         Absolute
         Scaled

4 Marker Size Specification Mode
         Absolute
         Scaled

5 Edge Width Specification Mode
         Absolute
         Scaled

6 VDC Extent
7 Background Color

Control Elements: Class 3

1 VDC Integer Precision
         8, 16, 24, 32

2 VDC Real Precision
         Floating Point
         Fixed Point

3 Auxiliary Color P
4 Transparency P
5 Clip Rectangle
6 Clip Indicator

Graphical Primitive Elements: Class 4

1 Polyline
2 Disjoint Polyline
3 Polymarker
4 Text
5 Restricted Text
6 Append Text
7 Polygon
8 Polygon Set -
9 Cell Array

cell representation mode
  0  run length list mode -
  1  packed list mode P

(supported  only  if 
color selection mode is indexed)

10Generalized Drawing Primitive -
11Rectangle
12Circle
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13Circular Arc 3 Point
14Circular Arc 3 Point Close
15Circular Arc Centre
16Circular Arc Centre Close
17Ellipse
18Elliptical Arc -
19Elliptical Arc Close -

Attribute Elements: Class 5

1 Line Bundle Index
2 Line Type
3 Line Width
4 Line Color
5 Marker Bundle Index 
6 Marker Type
7 Marker Size
8 Marker Color
9 Text Bundle Index

10Text Font Index
11Text Precision -
12Character Expansion Factor -
13Character Spacing -
14Text Color
15Character Height
16Character Orientation
17Text Path -
18Text Alignment
19Character Set Index -
20Alternate Character Set Index -
21Fill Bundle Index
22Interior Style
23Fill Color
24Hatch Index
25Pattern Index
26Edge Bundle Index
27Edge Type
28Edge Width
29Edge Color
30Edge Visibility
31Fill Reference Point -
32Pattern Table
33Pattern Size -
34Color Table
35Aspect Source Flags -

Escape Elements: Class 6

1 Escape -

External Elements: Class 7

1 Message -
2 Application Data -
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The following text fonts are recognized and are mapped onto the Macintosh fonts, provided that the 
name of the font exists in the CGM Font List command -

CGM Font name Macintosh Font name

New York New York
Geneva Geneva
Monaco Monaco
Venice Venice
London London
Athens Athens
San Francisco San Francisco
Toronto Toronto
Chicago Chicago
Cairo Cairo
Los Angeles Los Angeles
Zapf Dingbats Zapf Dingbats
Bookman Bookman
New Helvetica Narrow New Helvetica Narrow
Palatino Palatino
Zapf Chancery Zapf Chancery
Times Times
Helvetica Helvetica
Courier Courier
Symbol Symbol
Taliesin Taliesin
Avant Garde Avant Garde
New Century Schoolbook New Century Schoolbook
Sans Serif Helvetica
Serif Stroke Times
Swiss Helvetica
Swiss Raster Helvetica
Sans-Serif Stroke Helvetica
HERSHEY:CARTOGRAPHIC_ROMAN Courier
HERSHEY:CARTOGRAPHIC_GREEK Symbol
HERSHEY:SIMPLEX_ROMAN Courier
HERSHEY:SIMPLEX_GREEK Symbol
HERSHEY:SIMPLEX_SCRIPT Venice
HERSHEY:COMPLEX_ROMAN Times
HERSHEY:COMPLEX_GREEK Symbol
HERSHEY:COMPLEX_SCRIPT Venice
HERSHEY:COMPLEX_ITALIC Courier
HERSHEY:COMPLEX_CYRILLIC Venice
HERSHEY:DUPLEX_ROMAN Helvetica
HERSHEY:TRIPLEX_ROMAN Times
HERSHEY:TRIPLEX_ITALIC Times
HERSHEY:GOTHIC_GERMAN London
HERSHEY:GOTHIC_ENGLISH London
HERSHEY:GOTHIC_ITALIAN London
NBS HERSHEY:CARTOGRAPHIC_ROMAN Courier
NBS HERSHEY:CARTOGRAPHIC_GREEK Symbol
NBS HERSHEY:SIMPLEX_ROMAN Courier
NBS HERSHEY:SIMPLEX_GREEK Symbol
NBS HERSHEY:SIMPLEX_SCRIPT Venice
NBS HERSHEY:COMPLEX_ROMAN Times
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NBS HERSHEY:COMPLEX_GREEK Symbol
NBS HERSHEY:COMPLEX_SCRIPT Venice
NBS HERSHEY:COMPLEX_ITALIC Courier
NBS HERSHEY:COMPLEX_CYRILLIC Venice
NBS HERSHEY:DUPLEX_ROMAN Times
NBS HERSHEY:TRIPLEX_ROMAN Helvetica
NBS HERSHEY:TRIPLEX_ITALIC Times
NBS HERSHEY:GOTHIC_GERMAN London
NBS HERSHEY:GOTHIC_ENGLISH London
NBS HERSHEY:GOTHIC_ITALIAN London
COURIER B Courier
COURIER OBLIQUE Courier
COURIER OBLIQUE B Courier
HELVETICA B Helvetica
TIMES B Times
TIMES ITALIC Times
TIMES ITALIC B Times
TIMES ROMAN Times

Undefined  Fonts  or  Fonts  not  appearing  in  this  list  will  be  arbitrarily  mapped  onto 
Macintosh Fonts.
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Appendix  C:  Output CGM Elements

Listed below are the CGM Elements that PICT to CGM supports in the CGM creation process.

   output
-    ignored

Element Code Element Name PICT to CGM    support  

Delimiter Elements: Class 0

 1 Begin Metafile
 2 End Metafile
 3 Begin Picture
 4 Begin Picture Body
 5 End Picture

Metafile Descriptor Elements: Class 1

  1 Metafile Version
=1 normally
=2 only when the the Pixel Map output option, "Cell Array" is 

selected along with the Direct color mode option.
The CGM Admendment 1, (version 2) allows changes of 
the color mode between direct and indexed modes within 
the same picture body.

  2 Metafile Description
  3 VDC type

     Integer
  4 Integer Precision 16
  5 Real Precision

     32-bit fixed point
Only as a description in the CGM. 

  6 Index Precision 16
  7 Color Precision 16
  8 Color Index Precision 16
  9 Maximum Color Index -
10 Color Value Extent

(0, 0, 0) to (1000, 1000, 1000)
11 Metafile Element List
12 Metafile Defaults Replacement -
13 Font List

Only if option is selected.
14 Character Set List

1  basic 8-bit or
4  complete code, (*: for Macintosh

15 Character Coding Announcer -
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Picture Descriptor Elements: Class 2

  1 Scaling Mode
     Abstract
     Metric

  2 Color Selection Mode
     Indexed
     Direct

  3 Line Width Specification Mode
     Absolute

  4 Marker Size Specification Mode
     Absolute

  5 Edge Width Specification Mode
     Absolute

  6 VDC Extent
  7 Background Color

Control Elements: Class 3

  1 VDC Integer Precision 16
  2 VDC Real Precision -
  3 Auxiliary Color -
  4 Transparency -
  5 Clip Rectangle -
  6 Clip Indicator

Graphical Primitive Elements: Class 4

  1 Polyline
  2 Disjoint Polyline -
  3 Polymarker -
  4 Text
  5 Restricted Text -
  6 Append Text -
  7 Polygon
  8 Polygon Set -
  9 Cell Array

cell representation mode
1 packed list mode

10 Generalized Drawing Primitive -
11 Rectangle
12 Circle
13 Circular Arc 3 Point -
14 Circular Arc 3 Point Close -
15 Circular Arc Centre -
16 Circular Arc Centre Close -
17 Ellipse
18 Elliptical Arc -
19 Elliptical Arc Close -
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Attribute Elements: Class 5

  1 Line Bundle Index -
  2 Line Type
  3 Line Width
  4 Line Color
  5 Marker Bundle Index -
  6 Marker Type -
  7 Marker Size -
  8 Marker Color -

  Markers are output as text type.
  9 Text Bundle Index -
10 Text Font Index
11 Text Precision -
12 Character Expansion Factor -
13 Character Spacing -
14 Text Color
15 Character Height
16 Character Orientation
17 Text Path -
18 Text Alignment
19 Character Set Index -
20 Alternate Character Set Index -
21 Fill Bundle Index -
22 Interior Style
23 Fill Color
24 Hatch Index
25 Pattern Index
26 Edge Bundle Index -
27 Edge Type
28 Edge Width
29 Edge Color
30 Edge Visibility
31 Fill Reference Point -
32 Pattern Table
33 Pattern Size -
34 Color Table
35 Aspect Source Flags -

Escape Elements: Class 6

  1 Escape -

External Elements: Class 7

  1 Message -
  2 Application Data -
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Appendix  D:   References

ANSI X3.122-1986 American National Standard for Information Systems - Computer Graphics - metafile for 
the storage and transfer of picture description information.

The CGM standard is also being processed through the International Standards Organisation (ISO).  It is 
known as ISO 8632.

The American National Standard for Binary Floating-Point Arithmetic (ANSI/IEEE 754-1985) is used for the 
floating-point representation within the binary encoding.

ANSI®
American National Standards Institute, Inc.
1430 Broadway, New York, New York 10018

SYMBOLIC COMPUTATION, CGM and CGI, Metafile and Interface Standards for Computer Graphics,  by 
David B. Arnold and Peter R. Bono,  Publisher Springer-Verlag 1988.
ISBN 3-540-18950-5 Springer-Verlag Berlin Heidelberg New York
ISBN 0-387-18950-5 Springer-Verlag New York Berlin Heidelberg

The Computer  Graphics Metafile,  by Lofton R.  Henderson and Anne M. Mumford,  Butterworths & Co. 
(Publishers) Ltd., 1990.
ISBN 0-408-02680-4
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